Micro Focus Enterprise
Developer 2.3 Update 2 for
Visual Studio

Release Notes



Micro Focus

The Lawn

22-30 Old Bath Road

Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com

Copyright © Micro Focus 2012-2016. All rights reserved.

MICRO FOCUS, the Micro Focus logo and Enterprise Developer are trademarks or registered
trademarks of Micro Focus IP Development Limited or its subsidiaries or affiliated
companies in the United States, United Kingdom and other countries.

All other marks are the property of their respective owners.

2016-10-06



Contents

Micro Focus Enterprise Developer 2.3 Update 2 for Visual Studio Release Notes

............................................................................................................................. 4
WaAT'S NEBW e e e e e e e e e e e et e e s e b e e e et e e e eaa e e reraanns 6
Significant Changes in Behavior or Usage ........ccccceviiiiiiiiiie e 10
KNOWN IS SUBS oottt e e et e e e e e e e e et e et e ea e b e et e eaeeas 12
RESOIVEA ISSUBS ..o e e e e et e e e e e eaans 14
Other Issues Resolved in ThiS Release ... 43
LTSy =11 F= 4 0] o 45

Before INSTAlliNg et e e e e e e e 45
Downloading the ProdUCE  ......oooiiiiie e 45

ON WINAOWS ittt e e e et e e e e e ee e e e e e e eaate e e e e s eatateeeeeessbanaaeseees 45

(@ LT U 1N PP 48

BasSiC INSIAllAtiON  .oooeieiiiiie et e e e r e eearaan 51
1S3 7= 11T T PR U TP 51

Installing Micro Focus Enterprise Developer Unix Components  ........cccccccevvviiinnne 52

Advanced INStallation TASKS  ..eevuiiiiiiiiie e e aees 53

ON WINAOWS ettt e e et e e e e e ea e e e e e e eaate e e e e e sabat e eeeeessbanaaaaseees 53

(O LT 1N PP 54

ATLEr INSTAIlING o e et e e e e e e e e e s e e e as 56

ON WINAOWS ettt e e et e e e e e ea e e e e e e eaate e e e e e sabat e eeeeessbanaaaaseees 56

(O LT 1N PP 57

Licensing INfOrmation ... 59
To start Micro Focus License AdmINIStration  .....coooeiiiiiiiiii e 59
INSEAllING [ICENSES ettt et e e e e e e e s e e st et b e e e e e e e e e e e e e aaannes 59

If you have a liCeNnSe file ... 59

If you have an authorization COde ... 60

TO OBLAIN MOTE ICENSES ..ottt et e e e e e et e e e e e e aab e e e s eeraans 60
Updates and SUPPOITLINE ..o e e e e e 61
Further Information and Product SUPPOIT  .....eeeiiiiiiiaiiiee e 61
INFOrMAation WE NEEBA .oeee et e e et e e e et e e e e e aab e e eeeeees 61
Creating DebUQg FIles e a e 62

(DT ESY el F= 11 2 L= 63

Contents | 3



Micro Focus Enterprise Developer 2.3
Update 2 for Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

i Note:

» This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

» Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

* Micro Focus Enterprise Developer Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is suitable for anyone
who wants to become familiar with the Eclipse or Visual Studio means of editing and compiling
mainframe applications under Windows.

* Micro Focus Enterprise Developer Connect

Enterprise Developer Connect is for customers looking to use modern and productive Eclipse-based
tooling to develop mainframe applications directly on the mainframe. Close integration to mainframe
configuration management systems and the ability to easily customize the Eclipse-based IDE to include
mainframe-based tools and processes means developers can take full advantage of modern
development tools without having to learn new development processes.

* Micro Focus Enterprise Developer

Enterprise Developer is for customers looking to develop and modernize mainframe applications in a
productive and modern Windows-based development environment, targeted for deployment onto an
alternate server platform. Developers have the choice of either the Visual Studio or the Eclipse-based
IDE and development and test tools are provided for all target environments currently supported by
Micro Focus.

* Micro Focus Enterprise Developer for IBM zEnterprise

Enterprise Developer for IBM zEnterprise gives customers the choice to develop directly on the
mainframe or under Windows. Mainframe applications can be developed, maintained and modernized
regardless of where they will be deployed, either back onto the mainframe or onto an alternative server
environment. Support is provided for both the Visual Studio and Eclipse-based IDEs and for all the
development and test tools for every target environment currently supported by Micro Focus - including
z/Linux, AIX and x86 environments.

Enterprise Developer for IBM zEnterprise combines all the capabilities of Enterprise Developer Connect
and Enterprise Developer.
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Full mainframe integration and the Application Workflow Manager are only available in the Eclipse-
based IDE.

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise

Developer in the product Help.
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What's New
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This release provides enhancements in the following areas:

* Integration with Visual Studio

« Building applications

e CICS Web services (Early Adopter Program)
e« COBOL language enhancements
« Compiler directives

» Database access - DSNREXX

« Debugging applications

« Dialog System GUI

« Enterprise Server with .NET

* File handling

e |IMS support

e Library routines

e PL/I support

* Tutorials

Integration with the Visual Studio IDE
Back to Top

This release provides the following enhancements in the integration of Micro Focus COBOL with the Visual
Studio IDE:

e A new menu command SQL Option for DB2 on the Tools menu enables you to access all the SQL
Option for DB2 utilities.

« Itis now possible to specify options for compiling native resource files (.rc) by accessing the file's
properties from within the IDE.

Editor improvements:

« Support for showing the margins and the ruler is now available for mainframe subsystem files:
Assembler, BMS, JCL, and IMS.
« Colorization of the code in the ToolTips for collapsed regions in the COBOL editor has been added.

* The Time and Date Warp options are now available on the Run-Time Configuration tab when editing
an application configuration file for native COBOL projects.

¢« Go To Next Method and Go To Previous Method editor context menu commands are now available
for native Object-Oriented and for managed COBOL code.

* Improvements have been made to editing performance.

Building applications
Back to Top
It is now possible to use the 64-bit version of MSBuild to build COBOL projects.

CICS Web services (Early Adopter Program)
Back to Top



/1, Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
“* finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.

The CICS Web Services feature is EAP for development and testing usage. It should not be used for
production deployment in this product release

This release provides an initial support for CICS Web services (CWS) using an SOAP-based provider and
requester modes and using HTTP or MQ as the transport mechanism. CICS Web services support the
Coded Character Set Identifier (CCSID) and configuring the CCSID is a prerequisite for CWS in all
environments.

i Restriction: Security and Web Service Atomic Transactions (WSAT) are not currently supported.

COBOL language enhancements
Back to Top

Numeric, edited and external floating point items can now specify USAGE NATIONAL when the
NATIONAL"2" Compiler directive is in effect. Signed numeric items must be specified with the SIGN IS
SEPARATE clause.

Compiler directives
Back to Top
The following Compiler directives are new in this release:

¢ COMMAND-LINE-LINKAGE - enables you to call a program and pass the command line to the main
program as a parameter to be accessed via the Linkage Section. This offers equivalent functionality to
the command_line_linkage tunable, which has now been deprecated.

« EBC-COL-SEQ - controls the behavior of an EBCDIC collating sequence, specified in a
NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long-standing fixed
(platform-independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

« NATIONAL - enables you to specify numeric, edited and external floating point items as USAGE

NATIONAL.
Database access - DSNREXX
Back to Top

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.

DSNREXX support is available for use with Enterprise Server using DB2 LUW and SQL Server. See
DSNREXX Support for more information.

Debugging applications
Back to Top

* You can configure the debug tooltip for subscripted OCCURS items to either display the elements of
arrays or to display the value of the current expression. To do this, right-click in the editor, click COBOL
Debug Tooltip Style and either enable or disable Show COBOL OCCURS or reference modification
value.

Dialog System GUI

Back to Top
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Installing the version of the Compatibility AddPack for Visual COBOL provided with this release adds a new
menu item, Micro Focus Dialog System, to the Tools menu of Visual Studio for starting the Dialog
System GUI from within the IDE.

Enterprise Server for .NET
Back to Top
This release provides enhancements in the following areas:

» Dynamic configuration of running regions using a new seesys command-line utility for re-cycling
AppDomains such as when new versions of programs have been deployed. seesys enables you to
replace any previously loaded programs without having to restart the region, or remove any unused
SEPs.

» Performance improvements - it is now possible to configure JES regions to reuse AppDomains that
were previously used to run a job's steps. The default behaviour is to unload the AppDomain at the end
of each job. Reusing AppDomains improves a job's throughput by eliminating assembly reloads.

« JES security support equivalent to that of the native Enterprise Server (i.e. external security managers
(ESMs)). Customers can now secure their JES regions using mechanisms similar to the native
enterprise server.

» JES spool housekeeping - you can now use the MVSSPLHK utility to archive JES spool output file data.

e Share catalog/spool between JES regions - A JES catalog and spool file can now be shared between
JES regions.

« Improvements to the system administration capabilities using the Microsoft Management Console
(MMC):

« A seemmcconfig command-line utility that enables you to configure regions.
* A number of enhancements in the spool view such as additional filters and columns, sortable
columns.

» Shared catalog configuration and security configuration
« JES program aliases

« Public class library enhancements - it is now possible to interact with the region to access the spool
functions and the security options.

e FTP and sFTP support for JES jobs that enables you to perform FTP functions from job steps, with or
without a secure layer.

» Support for IDCAMS DEFINE CLUSTER SHAREOPTIONS - provides improved mainframe emulation
of sharing VSAM files between tasks or jobs.

File handling
Back to Top
MFJSORT ICETOOL now supports the USING parameter in the SELECT operator.

IMS support
Back to Top
This release supports the PROMPT keyword in MFS source files.

Library routines
Back to Top
The following library routine contains new functionality:

e CBL_GET_PROGRAM_INFO - a new function (function 10) has been added for native COBOL which
returns the path and program name, or the program name only of a particular program.
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PL/I support

Back to Top

This release provides the following enhancements:

New built-in functions - support has been added for the ONCONDID() and SAMEKEY() built-in
functions.

Support for strings declared with the VARYINGZ attribute - the Open PL/I compiler and run-time system
now support the use of VARYINGZ strings as variables, parameters, and targets for built-in functions.
This provides an improved compatibility with IBM's mainframe compiler, and the ability to more easily
interact with other languages such as ANSI C.

Improved PL/I macro preprocessor compatibility - the Open PL/I compiler now supports all macro
preprocessor built-in functions used by IBM's PL/I Macro Preprocessor.

Improved compatibility with IBM's Structure Alignment rules - the -zalign option of the Open PL/I
compiler now maps structure elements of the BIT data type that do not consume a full byte to the same
boundaries as IBM's PL/I compiler. This helps make the migration of mainframe data files to a
distributed platform easier and improves the program execution compatibility.

Improved floating point support - the Open PL/I Code Generator now utilizes the newer Intel floating
point operands for improved speed. In addition, the Code Generator now provides improved
compatibility with passing parameters between C and COBOL.

PL/I editor improvements:

» The drop-down list of types and members in the Visual Studio editor now shows the PL/I types and
members.

Tutorials

Back to Top

The product help includes the following new tutorial:

Tutorial: DSNREXX, that walks you through the process of executing DB2 LUW queries using
DSNREXX.

What's New
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Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

» Enterprise Server

» Compiler

e MF Directory Server

¢ Monitoring and Management
e JCL Support

e PL/lI Support

¢ Run-Time System

Compiler
Back to the list

* The ILPINVOKE directive is now allowed only in an initial $SET. This is in line with similar directives like
ILREF and ILTARGET. Previously, the ILPINVOKE directive was allowed in other positions in the source
code, but could later result in 'Insufficient memory' errors.

2860347 (1104422)

* Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)

e There is no longer a problem opening an RM/COBOL indexed file when the program has a RECORD
CONTAINS n CHARACTERS clause and there are record descriptions with lengths less than n. This
situation previously caused a 39 error on the OPEN (other than OPEN OUTPUT) because there was a
mismatch in the minimum record length.

Enterprise Server
Back to the list

* Previously, it was possible to install groups that should not have been installed. If a group name, as
defined in the Startup List, did not exist in the list of Groups then the next Group in the alphabetical
order would be loaded instead. Now, if a Group is not defined in the list of Groups, a warning that the
Group could not be loaded is issued.

2869848 (619107)

MF Directory Server
Back to the list

« The "-n" option for the mfds command now supports hostnames as the network addresses in addition to
IPv4 addresses.

2816871 (1099564)

Monitoring and Management
Back to the list
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* Messages that are written to the console log by applications that perform "display upon console" now
contain a standard message ID (CASMGO0001I).

2854207 (1103659)

JCL Support
Back to the list

e A printer exit can now evaluate the spool copybook field Ik-dest-source-is to find the source of the value
in the spool DEST-NODE and DEST-USERID fields, to determine if it is from a SYSOUT 'DEST=' value
or from a /*ROUTE PRINT value.

2852302 (1103304)

PL/I Support
Back to the list

* A problem with PUT STRING when compiled with the -bigendian option in effect has been fixed. Note
that when upgrading to ED 2.3 U2 you must recompile any program using PUT SPRING.
2857374 (1104039)

» Previously, if using the -incafter option of the macro preprocessor to infuse a %INCLUDE with macro
logic, you were required to schedule a second macro pass to preprocess the contents of the

%INCLUDE. This is no longer necessary and the macro logic will be preprocessed on the first macro
pass as if it was part of the original source.

« Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)

* Previously, if SIGPIPE was triggered when a PL/I program was in the callstack, then PL/I error handling
got control and processed the ERROR. This no longer occurs. Users who rely upon catching SIGPIPE
can re-enable it by adding a call to cobpostsighandler() to their code to turn it back on.

2859980 (1104399)

Run-Time System
Back to the list

« The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

2838118 (1101539)

Significant Changes in Behavior or Usage | 11



12

Known Issues

Known Issues

Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Enterprise Server

The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

In Enterprise Developer 2.3, some job scheduling tools from third-party vendors might stop
communicating with Enterprise Server. This might have an impact on our external partners who
integrate with Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur
with job schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment
with the path set. Click here for more information about the issue and how to work around it.

IDE

When you add a COPY statement in a COBOL program and then show it in Expanded Copybook View,
the line for the copybook statement is read-only. If you then perform an Undo in the COBOL program,
the COPY statement is removed while the contents of the copybook is still shown in the program.
Replace All does not work inside the Expanded Copybook View

For copybooks with file extensions that are not traditionally associated with COBOL you must first add
the file extension to the list of known copybooks extensions in Tools > Options > Text Editor > File
Extensions before you can show them in Expanded Copybook View.

Linking

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Mainframe Access

After a QSAM text export, for some files you might incorrectly receive a message that a record's length
exceeds the data set LRECL. Micro Focus recommends that you check the exported data set for
completeness.

Micro Focus Rumba

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus


http://community.microfocus.com/microfocus/mainframe_solutions/enterprise_server/w/knowledge_base/28093.3rd-party-job-scheduling-tools-stop-communicating-with-edes-version-2-3.aspx

Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

PL/I Support

e The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.

« Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters

e Trying to deploy the local resource adaptor mFcobol-localtx. rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa. rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

e HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Known Issues
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Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

* Assembler Support

¢ CICS Support

e Code Analysis

* Codeset Support

« Common Communications Interface
* Compiler

e Communications Server

« Data Tools

» Debugging

« Dialog System

« Documentation

« Editor Writing Assistance

* Enterprise Server

» Enterprise Server for NET
« File Handling

* H2cpy
* HCO for Microsoft SQL Server
« IDE

e IMS Support

e JCL Support

¢ Mainframe Access

« Mainframe Batch Scheduler Integration
e Micro Focus Directory Server
*  MVS REXX Emulation

* OpenESQL

e PL/I Support

¢ Run-Time System

e SQL: COBSQL

e SQL: HCO for DB2 LUW

e SQL: HCO for SQL Server

¢ SQL: OpenESQL

e SQL Option for DB2

* XML Syntax Support

Assembler Support

Back to the list

« Anissue where GENCB macro was causing SOC1 ABENDS at execution time has been fixed.
2864941 (1105224)

« STOW macros now accept invocations which omit the third argument. For example: STOW
(1),PDSNAME CLOSE MEMBER W/O REPLACE

2868167 (1105603)
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BPAM (Basic Partitioned Access Method) emulation has been fixed to allow an open output of PDSs
with no members.

2868167 (1105604)

Assembler LAY instructions were incorrectly Soc5 abending when a negative displacement was
specified. This has been fixed so instructions of the form LAY 14,-262144(,14) work correctly.
2862443 (1104723)

Assembler Add Packed (AP) instruction was not detecting numeric overflow as per IBM's z/OS
specifications for 32-bit mathematical operations. The overflow detection logic in the Assembler Run-
Time system has now been changed to properly detect all condition codes associated with 32-bit add
operations.

2861800 (1104652)

CICS Support
Back to the list

Previously, HSF records for CICS transactions were incorrectly given a type of JCL under SSTM.
2854986 (1103786)

A trap could sometimes occur if an EZASOKET call was made before MFCS was ready to process the
call.

2861431 (1104615)

CICS SEND FROM statements now support a new option, _NOCONVERT. When this is set, the
associated data stream will not be converted between ASCII and EBCDIC.

2858809 (1104228)

During the auto-install of a terminal that would result in a duplicate terminal, the duplicate terminal
would hang and each attempt to reconnect would create a new invalid terminal entry. Also, attempts of
an IMS terminal that uses a predefined NETNAME to reconnect would fail.

2857211 (1104013)
When trying to write to the local trace table, a flag was not initialized properly which resulted in a crash
in casgreqt.

2854635 (1103673)
An issue causing some memory leak has been fixed.
2848625 (1102926)

When an ambiguous handle does not need to be qualified within an exec cics statement (i.e. a
paragraph exists in the same section as the exec cics statement, and a duplicate paragraph name
exists in another section), "COBEC1402S HANDLE label not unique" will no longer be returned.

2871628 (1106156)
The NOCONVERT and CCSID options are now supported in the GET/PUT CONTAINER APIs.

2830735 (1100803)
Non-unique locations within EXEC CICS statements are now flagged as Not Unique when compiled if
they need to be qualified.

An issue where CICS INQUIRE REQID returned EIBRESP=NORMAL even when no REQID was
present in the system has been fixed.

2870593 (1106043)
A CWI group in the startup list would cause intermittent 252 Run-Time System errors in casgate,
especially under load.

2865028 (1105237)

Resolved Issues
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Timeouts specified by ECI clients are now honored.

2864330 (1104999)

Previously, data returned on an EXEC CICS READQ TD command could be truncated. This could only
occur for regions running without TRANCLASS specified.

2863822 (1104922)
The value of IDAREALEN in T-TYPE definitions is now honored during the auto-installation of the

Universal Client terminal.

2863437 (1105060)
An issue causing a memory leak when using CICS POST has been fixed.

2862452 (1104719)
An issue causing file locks when using CICS SPOOLOPEN has been fixed.

2858609 (1104717)

An issue with CWS using MQ transport where the reply was sent to the dead letter queue instead of to
the reply queue has been fixed.

2858022 (1104129)
SET TERMINAL NEXTTRANSID is now being honored.

2851169 (1103193)
An INQUIRE DSNAME now returns the dsname when ES_INQFILE_RETURN=DSN even if the datafile

has not yet been opened since the region started.

2850740 (1103167)

If a region was active when a daylight savings or other timezone change was made, the new time would
not be reflected in the CICS ASKTIME API. The PERFORM RESETTIME command now behaves in the
same way as under CICS on the mainframe allowing a user-written program to update the system to
use the new time.

2842910 (1102203)

The BMS field attributes are now correctly applied for fields that are defined within a group.

2839597 (1101990)
Enterprise Server now supports the CICS API SET TASK Purge, Forcepurge and Kill commands.

2810092 (1098212)

The following new trace flags are now available in the System Initialization Table (SIT): srv - traces SEP
hosted task control functions; pcp (program control program) - traces program management functions.
When MFDS uses SSL ports and the user navigates to ESMAC from MFDS, the HOME link now points
to the correct SSL port.

2863039 (1104794)

A problem with the CICS API FORMATTIME incorrectly truncating seconds has been corrected. The
milliseconds value is how truncated if the milliseconds value is not requested.

2868459 (1105680)

A problem with user names and passwords importing into the resource definition file as upper case has
been fixed.

2868202 (1105606)

It is now possible to run the casrdtex command on resource definition files defined with read-only
access.

2852401 (1103335)

Code Analysis

Back to the list

Resolved Issues



* The GO TO statements targeting non-exit paragraphs query no longer returns points inside EXEC
statements.

» The performance has been improved.

« The criterion for dead statements within a program has been modified to exclude child elements of
statements.

« Level 78 constant names used in picture definitions are now replaced with the actual values.
* An issue with de-referencing NULL pointers during program generation has been fixed.
* Anissue with de-referencing a NULL pointer has been fixed.

Codeset Support
Back to the list

* A number of DBCS translation tables for CODESET have been added to the deployment product to fix
the 'COBRT255 CODESET cannot open double byte conversion table' error.

2858171 (1104157)

* The following changes have been made to CODESET tables: « The Japanese Katakana Extended
codeset (country code 81) now corresponds to EBCDIC code page 290 when converting between
ASCII and EBCDIC, which means lower case letters (which start at x61, and not x81) can now be
converted. « Unused entries for the following codesets have been filled in order to allow round tripping
(ASCII>EBCDIC>ASCII conversions) of SBCS values: « Japanese Latin Extended, country code 939,
which corresponds to EBCDIC code page 1027. « Korean, country code 82, which corresponds to
EBCDIC code page 833. « Simplified Chinese, country code 86, which corresponds to EBCDIC code
page 836. « Traditional Chinese, country code 886, which corresponds to EBCDIC code page 37.

Common Communications Interface

Back to the list

« The formatting of the context help pages for the Enterprise Server Administration HTML GUI has been
improved.

Communications Server
Back to the list

* MFCS now accepts security configurations which do not include optional data such as the "Authorized
ID" for security managers.

2865680 (1105868)

« Enterprise Server now provides some new options for EZ Sockets support for Mainframe Subsystem
Enterprise Server applications. You can use these options to enable your applications to share sockets
without using GIVESOCKET/TAKESOCKET. See the product Help (available from
documentation.microfocus.com) for a description of the "share descriptors" option.

2863608 (1104885)

* TN3270 conversations no longer hang, looping in the MFCS process, if the client sends a malformed
TN3270E header. A message will now be written to the MFCS log and the input record will be
discarded.

Compiler
Back to the list

« When a program uses SQL, the debugger could highlight the wrong line when entering that program.
This has been fixed.

2869190 (1105765)
* On 32-bit Intel platforms you could receive an error "001-F Internal error 38" when generating for debug.

Resolved Issues | 17
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Resolved Issues

2856865 (1104040)
A COBRT114 error produced at generate time has been fixed.

2853877 (1103611)
An error in the "ACCEPT binary-floating-point-item" syntax, which occurred on Intel x86 platforms in 32-
bit generated code, has been fixed.

If more than one report shared the same FD, for example: REPORTS ARE REPORT-1 REPORT-2. then
under HOSTRW, the record length was wrong. This has been corrected.

2865849 (1105553)

Programs using B-AND, B-OR, or B-XOR now compile with the ARITHMETIC'"ENTCOBOL" Compiler
directive in effect.

2864991 (1105087)
A DISPLAY statement containing a very large number of operands now compiles as expected.

2864361 (1105017)
An inline method invoke with a variable-length group item now produces correct object code.

2864131 (1105018)

Report Writer now generates the correct record length. Previously, if the BLOCK CONTAINS clause
came after the RECORD CONTAINS clause in the File Descriptor, the BLOCK would corrupt the value
from the RECORD clause, causing the record to have the wrong length when written to the file.

2863045 (1105008)
The use of 'AS' as a data-name for programs using an SQL ECM now works as expected.

2863002 (1104821)
If an INVOKE statement specifies more parameters than the method actually has, an appropriate error
message is produced. Previously, an 'internal error' error message was produced.

2860899 (1104519)
An INITIALIZE statement performed on a subscripted table containing fields that are object references
or procedure pointers now executes as expected.

2860416 (1104588)
Messages produced by the FLAGSTD directive now have the correct line and column info reported in
the IDE.

2859026 (1104318)

A COBOL program compiled with the PROFILE Compiler directive now shows information on the
number of times the program has been called, as well as loaded.

2858944 (1104278)
When REPLACE is active, a literal containing

2858804 (1104264)
A compilation where a user pre-processor is specified below CP in the pre-processor stack, and this
pre-processor passes COPY statements through unopened, now works as expected.

2858013 (1105427)
Compilation of a STRING statement, with an operand that reference modifies the result returned by a
user function, now works as expected.

2857266 (1104189)

A new directive, EBC-COL-SEQ, now controls the behavior of an EBCDIC collating sequence, specified
in a NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long standing
fixed (platform independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

2856776 (1104074)

now compiles as expected.



SCREEN SECTIONSs with very large amounts of fields, which worked in Net Express, now work in
Visual COBOL.

2854533 (1103648)
Copybook dependency information is now shown correctly in Eclipse for programs compiled with a
preprocessor such as CP.

2854371 (1103662)

Compiler warning message "COBCH972 Linkage item (or subordinate item) is referenced but has no
addressability" is no longer produced inappropriately.

2854113 (1103542)
The use of the HOSTRW and CURRENT-DATE directives no longer causes an excessive number of
lines in a report produced from the Report Writer.

2853789 (1105472)
Subscripts specified via intrinsic function LENGTH-AN no longer receive spurious boundary violation
error messages.

2851928 (1103254)
Preprocessor created error messages containing SJIS characters are now displayed correctly, as
expected.

2646229 (1089272)

A USE FOR DEBUGGING statement that references a table item and is triggered by a condition where
the table item is referenced but not evaluated (due to short-circuit evaluation) now executes as
expected.

2433731 (1073167)

There is a new option, CP, in EXECPERIOD. It controls the processing of periods that follow EXEC
statements. In most scenarios, the default option, EXECPERIOD(SMART), enables you to compile by
applying a flexible behavior based on the program's context.

2867788 (1105608)

If a program contained 'PERFORM of section-name THRU paragraph-name', where the section-name is
known to terminate, the compiler erroneously assumed that the PERFORM THRU terminates (which is
not necessarily the case when paragraph-name is within section-name). This meant that no code was
generated for any statements following that PERFORM statement. This is now fixed.

2871380 (1106107)

When ILSMARTLINKAGE was specified for a program compiled with the directive ODOSLIDE (which is
set automatically when a mainframe dialect is used), and when the program contained a linkage section
record with multiple OCCURS DEPENDING ON items, then illegal code was being produced with
multiple error messages. This is now fixed.

2870166 (1105899)

Index names (that is, names defined using INDEXED BY) in the Linkage Section were being allocated
in local storage. This is correct for linkage records in methods, but for procedural programs, they need
to be allocated in working-storage for compatibility with previous behavior. This is now the case.

2870162 (1105922)

If the OUTDD or INDD directives were in effect, but the CHARSET directive was set to ASCII, then use
of a DISPLAY statement could result in a warning about a 'Reference to undeclared extern assembly'.
This has been fixed. (Note - this situation could arise by setting DIALECT to a mainframe variant such
as ENTCOBOL (which in turn sets OUTDD/INDD), and then setting CHARSET"ASCII".)

2869937 (1105859)

Level 66 items declared as instance or static data in a class are now accessible from methods.
Previously, attempting such an access produced a compile time error.

2869374 (1105791)
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The ILMAIN directive being set no longer results in incorrect code being generated for the EXIT
PROGRAM statement.

2868383 (1105651)

If two overloads exist for a method with identical parameters except that one has an additional optional
parameter, then an invocation of the method specifying only the fixed parameters will now choose the
overload without optional parameters. Previously the method with optional parameters was chosen.

2867722 (1105552)

When compiling for .NET, a sequence of two or more IF NUMERIC tests joined together by the OR
operator no longer causes the Compiler to crash with an error 114.

2866846 (1105400)

In previous versions of the product, a comparison between an arithmetic expression and a single-digit
literal or data item could produce invalid code in the case where CHARSET"EBCDIC",
HOSTNUMCOMPARE and ILVERIFY were all set. This is now fixed.

2866229 (1105284)

Whilst debugging, it is now possible to examine the value of an INDEXED BY item declared inside the
LINKAGE SECTION of a program.

2864353 (1105075)

The CURSOR IS syntax in the SPECIAL-NAMES paragraph is now working correctly for managed
COBOL code.

2863432 (1104897)

The use of an EVALUATE statement in one of the WHEN branches of an outer EVALUATE statement no
longer has the effect of switching off the HOSTNUMCOMPARE directive.

2863206 (1104921)

A TABLE OF expression that includes a subscripted item in its list of operands no longer generates bad
code; previously, this was leading to an invalid program.

2860957 (1104571)

A COMP-X operand used as a second (or subsequent) operand to a full-screen DISPLAY statement no
longer causes generation of bad code. A move of low-value (or other non-numeric alphanumeric literal)
to a PIC 9(4) display data item now follows RM rules when the ACU dialect is in effect.

2860907 (1104515)

With ILSMARTLINKAGE, the data access get method for data with multiple subscripts was being
generated incorrectly. This could mean that the value passed for subscripts other than the first was
being ignored. This is no longer the case.

2859095 (1104263)

When a referenced assembly was loaded, but one or more of its dependent assemblies could not be
found by the Compiler, unreported errors could occur. In particular, this could have the effect that
operator overloads (such as the equality operator for items of type string) were not found. In the case of
string comparisons, this could then result in two strings with the same contents (but different object
references) comparing unequal. Such behavior is now fixed.

2857192 (1104066)

An issue where Content Assist/IntelliSense did not offer all available extension methods has been
resolved.

The LENGTH OF expression is no longer allowed on an object expression; an error (COBCH1869) is
produced if attempted. For objects of type string, collection types, or single dimensional managed
arrays, the SIZE OF expression can be used to determine the current size (i.e. the length of string or of
the managed array, or the number of elements in the collection).

Data Tools

Back to the list

Resolved Issues



DFCONYV now correctly supports a command line length of 1024 characters, as documented.
2868190 (1105640)
The classic Data File Tools utility now shows the correct field sizes for PL/I array elements.

2858068 (1104147)
The DFCONV utility now converts correctly between IEEE and 370 floating points.

2857502 (1104054)

Debugging

Back to the list

Examining an object reference with a null value in Visual Studio no longer causes a Run-Time System
error 200 when the application completes.

2863181 (1104826)
Examining the value of a large OCCURS depending on item no longer crashes Visual Studio.

2855996 (1104988)

When debugging Object COBOL programs, methods can now be stepped into if the Visual Studio Autos
window is enabled.

Dialog System

Back to the list

Installing the Compatibility Addpack now adds a link for the Dialog System painter to the Tools menu in
Visual Studio.

2779520 (1094515)
The Dialog System configuration information can now be updated using the painter.

Documentation

Back to the list

The documentation of the format of CCI.INI has been corrected.

2867660 (1105532)

The product help now clarifies that navigation bar in Visual Studio displays the lists of the objects and
procedures used in the current program as well as the Procedure Division, any sections, paragraphs,
and group level data definitions and enables you to position the cursor on any of them.

2858290 (1104219)

The topic "Making the Most Out of The COBOL Editor" in the product help for Visual Studio now
provides a link to the information about limitations with single file support.

2858263 (1104217)
Information on setting the mfdepinst security credentials in the .mfdeploy file in the deployment parent
directory has been added to the documentation.

2854625 (1103607)
The product help now includes information about the ExcilRespException and InvalidDataException
classes and corresponding serialized form information.

2851195 (1103171)

Changing the project's connection type can result in the project losing the connection to its version
control system. You can re-establish the connection with your version control system in the Share
Project dialog.

2792882 (1101965)
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The product help has been updated to remove the requirement to install the gcc libraries. These
libraries are not required to install and configure the product and then for the basic functionality. gcc is
only required if you need to use C and COBOL together and gcc will be installed together with the
required development tools.

2863618 (1104878)
User exits MFDASIMP and MFDASEXP are now documented.

2858575 (1104507)
Updated the information on the action of the MFJESPWR user exit program contained in the
documentation.

2856725 (1103944)
The DATAFIELD built-in function has been removed from the documentation.

2852986 (1103391)

Details have been added to the topics "To enable Windows Event Logging" and "To enable Performance
Counters" to state that the user must be able to write to the appropriate registry, and have appropriate
privileges, to complete these tasks.

2840002 (617369)

ECI programs that use mfccl.jar raise an error exception, EXCIException, if exciRespl and exciResp2
are not both equal to zero. To ensure your ECI program captures all errors, you must catch this
exception in your code. Please add the following code snippet, which enables your program to compile
and execute properly: try { ... } catch(ExciException e) { String rcMsg = e.getRcMsg(); } If an error
occurs, rcMsg captures the appropriate error message.

2830787 (1100664)

The documentation for the “MF Directory Server Security” page has been clarified, to show that the
Security Facility Configuration parameters are available on this screen only when MFDS is configured to
use an ESF (i.e. setup to use a Security Manager other than "MFDS Internal Security"), otherwise no
ESF security configuration options (including the caching options) will be seen on this MFDS Security
tab screen. These parameters are: Allow unknown resources Allow unknown users Cache limit Cache
TTL Create audit events Verify against all Security Managers

The product Help now includes some additional details on creating advanced filters for using regular
expressions with the Compare and Synchronization Monitor.

2645110 (1089268)

Editor Writing Assistance

Back to the list

22 | Resolved Issues

IntelliSense (Visual Studio) and Content Assist (Eclipse) would sometimes not offer reserved word
types where they were valid.

IntelliSense (Visual Studio) and Content Assist (Eclipse) offered unqualified managed members where
they could not be used without qualification.

IntelliSense (Visual Studio) and Content Assist (Eclipse) sometimes offered invalid pointer items.
IntelliSense (Visual Studio) and Content Assist (Eclipse) incorrectly offerred level 88 itens or require
them to be qualified.

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer items in the PERFORM USING
statement.

An issue where members with reserved word names were not colorized correctly has been fixed.
IntelliSense (Visual Studio) and Content Assist (Eclipse) suggestions are now offered in member
headers for members with names that are reserved words.

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not show options after items which were
subscripted or reference modified.

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not correctly offer typedefs in LENGTH OF
phrases.



Items from external programs were incorrectly offered in IntelliSense (Visual Studio) and Content Assist
(Eclipse).

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer variables with the same name as
classes, methods or properties in the same file.

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer suggestions after variables with
the same name as classes, methods or properties in the same file.

IntelliSense (Visual Studio) and Content Assist (Eclipse) omitted options after the SET SIZE [OF]
statement.

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer items within indexers on natively
typed arrays.

IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer or recognise PIC 1 items within
conditional expressions.

IntelliSense (Visual Studio) showed the wrong members after a cast to SUPER.

IntelliSense (Visual Studio) and Content Assist (Eclipse) sometimes did not list any members after
names of unqualified types.

The Content Assist (Eclipse) and IntelliSense (Visual Studio) lists would not include any options if there
where unknown parameter types in the code.

Some IntelliSense (Visual Studio) and Content Assist (Eclipse) proposals for items from external
programs did not have any descriptions.

If there were multiple items with the same name declared in external programsm they were not offered
correctly by IntelliSense.

IntelliSense now supports constructing instances of the current or parent type using either NEW SELF
or NEW SUPER.

IntelliSense in Visual Studio would sometimes show the wrong members for unqualified type names
within partial classes.

Content Assist (Eclipse) and IntelliSense (Visual Studio) now offer to qualify file record items by their FD
items.

IntelliSense (Visual Studio) and Content Assist (Eclipse) would sometimes list the wrong members after
an unqualified type name.

Enterprise Server

Back to the list

The CASGLM.LCK and ESCLRMLs.cfg files were not generated if the system catalog was in a spacey
path.

The security when displaying any of the Enterprise Server configuration pages in the Enterprise Server
Administration HTML GUI has been increased.

2846702 (1102642)

The "Renew" command available from the left hand side navigation pane in the Enterprise Server
Administration HTML GUI did not work when SSL was enabled.

A potential memory corruption when a SEP executing an EXEC CICS DELAY is killed has been fixed.
This situation only occurred when TRANCLASS was enabled.

2865931 (1105228)

An initial 3270 terminal connection could hang if there was an attempt to send an error message to the
terminal not yet connected and an XA error occurred at the same time.

2865927 (1105226)
IN-only messages are now supported for CICS Web Services.

2864329 (1104991)
An issue causing an RTS 114 error in mfjclsub when a CICS program executed a 'display’ call in an
SSTM-enabled region has been fixed.

2858651 (1104770)

Resolved Issues
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It is now possible to programmatically change the name of a Web service displayed in the HSF records
by calling the following entry point: call 'ES_trace_application_data' using by reference ws-trace-block .
Where ws-trace-block is defined as follows: 01 ws-trace-block. 03 ws-trace-version pic x comp-x. 03 ws-
trace-data. 05 ws-trace-type pic x comp-x. 05 ws-trace-text pic x(255). - ws-trace-version and ws-trace-
type must have a value of 1. - ws-trace-text is restricted to 255 bytes in length, must be terminated by
low-values (x'00) and must not have any spaces embedded in it.

2856234 (1103860)

When using cassout from the API and not cancelling it between calls, it was possible to overwrite the file
output from a previous invocation if the '-d' option (output to file) was not specified. The product now
initializes the required environment variables on each invocation to ensure this problem does not occur.

2852058 (1103778)
Trying to access ESMAC in a secure region no longer results in the application crashing.

2851933 (1103724)

On a CICS stateful request, after a run-time system failure, a transient SEP could loop, produce an RTS
114 error or an abend CDCD on shutdown during SDP2. This was caused by the ATP not being at the
expected level when running SDP2.

2851618 (1103389)

The casutl command line utility supports a new option, /n. When used with /n, the utility starts a new
console.log and saves the contents of the current console.log to a new file,
console.nnn_switch_date_time (where nnn is a number).

2851178 (1103265)
Visual COBOL and COBOL Server with SOA now include castran with the CANCEL support.

2849934 (1103037)
Credentials are now masked out in the formatted dump.

2848888 (1102908)

A default password for an external Security Manager connection is no longer used when you specify a
user id but not a password. This is to help avoid locking out the user id. Also, if no password has been
specified, the Enterprise Server Administration HTML GUI no longer displays a dummy value in the
password field on the Security Manager configuration page.

2864790 (1105187)
Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.

2863222 (1104948)
Restricting access to the Enterprise Server External Security Facility's Admin API for the MLDAP ESM
Module now works correctly when you use resource definitions in the optional AdminAPI class.

2830660 (1100636)

With some types of tracing enabled, the MLDAP ESM Module for Enterprise Server security would
sometimes report that a group ACE matched the user's logon group when in fact it did not match. The
trace message now correctly indicates whether the ACE matched or not.

When using Enterprise Server security with LDAP, on some platforms, a resource access rule with an
empty access control list (ACL) could cause an RTS 114 or other program crash. This has now been
fixed.

Enterprise Server for .NET
Back to the list

Resolved Issues

The Enterprise Server for .NET documentation has been updated to include details of how to install the
seelistener and seemonitor services so they run under a specified user account. seelistener has been
enhanced to allow a custom configuration file to be used when installed as a service.

2865211 (1105110)



Several views in the Enterprise Server for NET's MMC Ul that need to access the cross-region
database did not ensure that it had been created before doing so.

(620540)

CPMT NEWCOPY failed under Enterprise Server for .NET when user impersonation had been
configured for the region.

Under Enterprise Server for .NET, if a SEP had a file open from an earlier transaction invocation, but
was now running some other transaction, the file did not get closed as it should if another running
transaction executed a SET FILE CLOSED command for it.

The Search functionality in the MMC console view has been improved.

The OUTPUT information was not available to printer exits when running JCL under Enterprise Server
for .NET.

2865466 (1105150)
Under Enterprise Server for .NET, the "SEECF0151W wassetup failed" message occurred during region
start-up if the seemonitor service was not running with administrator privileges.

2864919 (1105079)

The public class library of Enterprise Server for .NET has been enhanced to support access to spool
records when running under a JES region. This support allows job records to be retrieved, optionally for
a specified job name. A release, flush and/or a kill operation may subsequently be performed for a
retrieved job record.

2851046 (1103197)
The MMC Ul catalog view of Enterprise Server for .NET has been enhanced to allow the allocation and
editing of GDG models.

2848977 (1103722)

The Enterprise Server for NET MMC Ul SEP Traces view and the seedup output were displaying the
local trace table times as UTC instead of converting them to local.

In some circumstances the console viewer in the MMC Ul of Enterprise Server for .NET displayed a
large number of blank lines in between the actual console messages.

A job running under Enterprise Server for .NET that was blocked on an ENQed resource could not be
terminated by the MMC Ul or the casout/seeout command-line utilities.

An RTS 114 error occurred when the Enterprise Server for .NET JesDisplay.Write() public APl was
invoked with a message containing all spaces or an empty string.

When using Enterprise Server for .NET's MMC Ul or the seedeploy command-line to download a
database-hosted KSDS file, the file now gets created on disk using IDXFORMAT=8 - i.e. this now
creates a single file where previously this created separate data and index files.

When using Enterprise Server for .NET's MMC UlI, a file would not open in the Spool File if one with the
same job number, DD name and step name had already been opened. This problem would occur with
jobs that had two or more steps with the same name each having sysout DDs with the same name.
When running a batch job under Enterprise Server for .NET that invoked the SORT utility's HEADER1
and/or TRAILER1 commands, the output when written to a database-hosted file contained incorrectly
formatted headers and/or trailers.

Under Enterprise Server for .NET, when two or more jobs simultaneously opened a file hosted in a
database (one OPEN 1I/O or OPEN INPUT, and the other OPEN OUTPUT), subsequent I/O operations
by the job having the file OPEN I/O sometimes resulted in an I/O error.

When building a Managed Mainframe Subsystem Application project in Visual Studio that made use of
the MicroFocus.SEE.Commes.Public class library, the MicroFocus.SEE.Comms.Binp assembly was not
available for selection from the "Add Reference" dialog. This resulted in the project file having to be
manually edited to add the assembly reference.

When using Enterprise Server for .NET, an RTS 200 error occurred when attempting to use a non-
existent XA resource definition with a TSO DSN SYSTEM() RUN command when the machine.config
file did not contain a definition for the MicroFocus.SEE section.

In Enterprise Server for .NET, the batch jobs were not being scheduled correctly according to their
priorities.

Resolved Issues
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File Handling
Back to the list

« Aninternal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.

2868664 (1105707)

* When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler
was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.

2864802 (1106106)
» VB files are now created with the correct Irecl, taking into account the extra space for a print character
when creating the file header.

2856899 (1104023)

e FS_CHECK_FILE_EXIST is now being processed correctly when called with an environment variable
that contains a Fileshare server-name. Previously, the request was not being sent to the server.

2851717 (1103253)

« Memory is now correctly being deallocated at end of IMS rollback recovery processing; previously, it
was not.

2840046 (1101795)
* The rollback recovery process is now working as expected.

2802180 (1097066)

« For corrupted files, where a corrupted offset occurs beyond the end of the file, you now receive a
validation message instead of a Run-Time System error 114.

2860981 (1104576)

e When MFJSORT fails to open SYSOUT, it now gives an error message to the console, and then
abends.

2861239 (1104614)
 The MFJSORT E15 user exit is now giving the correct record length.

2858360 (1104276)
« A COBOL SORT called from JCL no longer causes a COBRT200 error message in managed code.

2857600 (1104073)
« SORT now treats leading spaces in ZD fields as zero, which emulates mainframe behavior.

2855141 (1103700)
« The conversion of PD to ZD is now giving correct SORT results for negative numbers.

2854443 (1103597)

H2cpy

Back to the list

« H2cpy now successfully parses cURL header files.
2858155 (1104162)

HCO for Microsoft SQL Server
Back to the list

e The OpenESQL pre-compiler generated code has been modified to perform swap logic for COMP fields
if an SQLCODE of -305 or -811 is also returned, as data can be returned with either of those
SQLCODEs.

26 | Resolved Issues



2871163 (1106063)
An issue with OpenESQL handling cursor names that start with "CURSOR" has been fixed.

2866507 (1105337)

An issue where HCOSS was not locating the correct stored procedure for a bound statement in multi-
step JCL jobs has been fixed.

2861657 (1104733)

When using DIALECT=MAINFRAME, if a program references a DECLARE GLOBAL TEMPORARY
TABLE before the declaration, the precompiler now produces a warning and not an error message.

2853667 (1103453)

IDE
Back to the list

In Visual Studio 2015 or later, the Properties window for assembly references might have incorrectly
displayed a value of "false" for the 'Copy Local' property.

2868449 (1105875)
Visual Studio should not support editing of data items at a group level. This is option is now disabled.

2864986 (1105083)

When debugging an application running on a remote machine with the expanded copybook debugging
enabled, the Visual Studio debugger now steps on the correct lines. In such cases, if the application
sources are not loaded in Visual Studio, the debugger will not step the copybooks inline. Instead, it will
open the copybooks in a separate tab in the editor.

2864082 (1105134)
Debug tooltips are now shown correctly in statements that contain multiple data items.

2862422 (1104764)
When building a COBOL project, outlining would be temporarily turned off for any open source files.

2860767 (1104493)

The IDE setting "Debug tooltip style for OCCURS items" in Tools > Options > Micro Focus COBOL >
Advanced has been renamed to "Show COBOL occurs or reference modification value" and is now
available under Tools > Options > Debugging->Micro Focus COBOL. While debugging, you can enable
this setting directly from the editor - either choose "COBOL debug tooltip style" from the editor context
menu or from the context menu of the debug tooltips.

2858786 (620858)
Watchpoints are now hit when debugging Mainframe Subsystem applications.

2857670 (1104106)

The environment variables specified on the Environment tab in the Application Settings dialog box when
you edit a project's Application.config file are now expanded when the application is executed from
within Visual Studio.

2853990 (619225)
The editor is now more responsive when editing large source files.

2852087 (1103629)

It is now possible to switch off the colorization of uncompiled code in the editor - click Tools > Options >
Text Editor > Micro Focus COBOL > Advanced and set "Enable inactive code colorization" to False.
Switching this setting off can help improve the editor performance.

The debugger is now positioned on the correct source line when debugging 64-bit Oracle Pro*COBOL
programs.

It is now possible to specify options for compiling native resources files (.rc) by accessing the files'
properties from within the IDE.

Resolved Issues

27



This release offers various improvements in the performance and stability of outlining support in the
COBOL editor.

The Call Hierarchy and Quick Browse window now display information about items with non-ASCI|
names.

IntelliSense and colorization did not work in the Visual Studio COBOL editor in sourceformat(free) when
the first word on the line started with a "d", and this was not a debug indicator.

When querying items, if you expand the tables and groups, they now show the element name rather
than a fully qualified name. This is to improve the readability.

Visual Studio could crash when attempting to use the "Debug/Attach to Process" feature and when
Visual Studio was started with non-administrator privileges.

In the Project Details Window, unchecking the Allow Columns Reorder context menu option would crash
the IDE.

Displaying the context menu for a file in the Project Details Window could sometimes cause the IDE to
crash.

IMS Support
Back to the list
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When a GE status (record not found) was returned when accessing a secondary index directly as a
stand-alone DB, the database position was lost. This has been corrected.

2859678 (1104360)

When using a PROCOPT=GO PCB to access a secondary index DB, a record locked status (9/068)
error message could occur when other active applications were updating adjacent records in the index.

2856236 (1103858)

Secondary Index sparse exit routines were allowed to run in parallel in the multi-threaded IMS DB
Control process. Exit routines are now serialized by default to prevent any possible unintentional
storage corruption by exit routines which are not thread-safe. If all sparse exit routines are thread-safe,
you need to use the configuration variable ES_IMS_SERIAL_SPARSE_EXIT=0 to allow exit routines to
be multi-threaded.

2856235 (1103857)

A qualified GU call to a PROCSEQ PCB with a key value greater than the last record of the SX DB
resulted in an unnecessary forward search across the entire SX DB. This has been fixed.

2855116 (1103841)

On a heavily loaded system running a combination of read-only batch and online shared database
applications (MPP, BMP, or CICS), an invalid file status of 42, 48, or 49 sometimes resulted on a
secondary database index. This has been fixed.

2850171 (1103561)

When editing an IMS database in the DB editor, a severe DLI call failure resulted in an editor crash
rather than setting the appropriate DLI status code. This has been corrected.

2849835 (1104252)

A DLI status code (NE) was returned incorrectly to DLET call depending on secondary index definitions
and data population. This has been corrected.

2847064 (1103584)

When a CHARSET(EBCDIC) program issued an EXEC DLI REPL call that omitted segments that were
included in the previous GET call, and then followed this with a path GET call, an invalid "AC" status
code resulted. This has been corrected. The correction does not require a recompile of the
CHARSET(EBCDIC) program. This issue does not apply to CHARSET(ASCII) programs.

2843343 (1102714)

The cursor position set by the application program on output is now working as expected. Previously,
the output cursor position was the positioned defined in the MFS source.



2868851 (1105753)

An issue in the DBCS support incorrectly sets the model 7 terminals to a screen width of 80 characters,
this resulted in invalid overlapping field errors. Model 7 screen width is now set to the correct value of
132 characters.

2863035 (1104790)
The output of IMS printed lines were one fewer than the number defined. This has now been fixed.

2859815 (1104349)

For LU3 printing, the print buffer will no longer contain any trailing spaces. LU3 printing has output
buffer size limitations. Trailing spaces could result in the buffer exceeding the limitation.

2857377 (1104041)

NULL characters defined in the MID are now correctly converted to the EBCDIC equivalent. This
addresses the problem where some code pages (for example, code page 932) like an ASCII null (x'1A")
does not convert to the expected EBCDIC null (x'3F").

2857213 (1104014)

User should no longer abend when generating a large MFS source. The literal pool sizes have been
increased to take into account an earlier increase to the number of MFLDs.

2856514 (1103910)

The dynamic modification of the color attributes from an EBCDIC COBOL program will now be honored.
Dynamically modifying extended attributes such as color and field highlighting works regardless of the
code base, ASCIl or EBCDIC of the COBOL program.

2853509 (1103505)
LU3-type printing from IMS transactions is no longer unexpectedly truncated.

2853494 (1103437)

If the MFS specifies that the print line should have spaces stripped, then all spaces following the last
significant data byte will be removed.

2853493 (1103436)

IMS system commands and paging requests will be honored when they occur in segments other than
the first and the preceding segments contain all NULLS.

2852124 (1103551)
The MFS PROMPT keyword in MFS source is how supported.

2818114 (1099103)

On a successful IMS CHNG call, a corrupted EBCDIC PCB name in ALT-IO PCB was sometimes
generated. This has been fixed to generate a valid EBCIDIC name.

2857243 (1104018)
RTS 114 errors no longer occur when printing from an IMS transaction while the printer is disconnected.

2857604 (1104070)

Printing from an IMS transaction no longer fails to print when the printer is not connected until after the
print request has already been sent by the transaction.

2857603 (1104068)

Printing a large number of pages from an IMS transaction no longer causes the transaction to abend.

2848152 (1102799)
Submitting a /FORMAT command with data no longer abends with a Run-Time System error 114.

2847486 (1102797)

A new Enterprise Server environment variable, ES_IMS_GOTO_CICS_ON_SIGNOFF, has been added
in this release. Set ES_IMS_GOTO_CICS_ON_SIGNOFF=Y to return users to CICS upon logging off or
timing out, rather than returning them to the IMS sign-on screen, which is the default behavior.

Resolved Issues
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2836417 (1102541)
A problem with incorrectly formatted output data appearing on IMS screens when default literals or
system literals were assigned to output message fields has been fixed.

2825068 (1100049)

JCL Support
Back to the list
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You no longer receive a U4038 abend when calling MFJZLPSA with a JCL that uses DFSRRCO00 and
BMP.

2869477 (1105804)

The IEBPTPCH utility now checks against code page 0290 for printable characters when running with
MF_CHARSET=EBCDIC and MFCODESET=9122.

2867654 (1105531)
An incorrect reason code was returned by mvscatpb when deleting a record in a user catalog.

2866782 (1105384)
Previously, when the output or output-hold job record was selected in ESMAC and deleted, the physical
spool files would be left.

2865754 (1105269)
Under VSE, when the environment variable ES_SAM_ESDS is set to Y, an open OUTPUT of a reusable
ESDS file resets the file in situations when the DISP is not specified in the DLBL statement.

2865599 (1105186)
The catalog list function now returns correct results when user catalogs exist.

2865225 (1105120)
Allocation overrides can be applied to a GDG model, and each GDG bias will use the folder location for
the physical file.

2865068 (1105102)

You can now use the environment variables MF_SPOOL_HK_OUTPRT and
MF_SPOOL_HK_LEX SCAN with the MVSSPLHK spool housekeeping utility. The values can also be
used in the utility configuration file.

2864993 (1105088)
A problem with the initialization of the JCL job number caused a hang on a region startup.

2863640 (1104883)
The mvscatpb public interface was missing the secondary space value and the directory blocks value.

2860753 (1104483)
The JCL user exit is now being called for the event step-bypassed.

2857924 (1104130)
A time-expired spool file will not be removed from the MVS Spool or the catalog if a record still exists in
casspool.

2857452 (1104079)
The JESO00915E error message now shows the correct userid.

2856571 (1103927)
Some issues that resulted in receiving sporadic locked record errors in the spool housekeeping utility
have been fixed.

2855421 (1103730)
DD DUMMY overrides are now correctly processed in concatenated SORT statements.

2853452 (1103435)



The record locking and reporting has been improved.

2853344 (1103438)

The archived files report of the MVSSPLHK utility, INDEXO, will now be populated when DATA-only
archiving is requested. The class-specific overrides are now applied.

2853244 (1103544)

The SYSOUT messages produced when the MVSSPLHK program was writing to an EBCDIC file were
corrupt.

2852020 (1103718)

The JCL job restart error messages for some of the known error codes now provide more specific
details.

2851945 (1103293)

IF the SYSUT2 DCB information is missing, IEBGENER now copies the DCB from SYSUT1 to SYSUT2
even when SYSUT?2 is specified as a SYSOUT dataset.

2851861 (1103357)

When using a DUMMY input file for IDCAMS operations, the dataset properties from a previous
operation could still be set.

2851041 (1103192)

When calling MVSSPLHK from user programs, the passed parameters are how respected.

2850869 (1103135)

A warning will be displayed in situations where a wildcard is used in the IDCAMS DELETE function and
a non-empty GDG base is encountered. This will not stop the deletion of other datasets.

2849270 (620072)
IEBCOPY now correctly copies the DCB attributes from INDD to OUTDD in situations where the
OUTDD DCB information is missing from the job.

2844219 (1102265)
ICEGENER and IEBGENER now support PDS members with names that start with numbers.

2843583 (1102530)
There is a new environment variable, ES_SSTM_JOB_FLUSH_ACTIVE. When this is set to Y, CICS

SSTM job will be removed from the ACTIVE queue when the region shuts down.
2843520 (1102320)
If a non-optional file is opened and it is present but virgin, the product returns a 3/5 status.

2832909 (616390)
Cataloged spool records are no longer removed if a corresponding casspool record still exists.

2832909 (1103892)
IDCAMS REPRO now only requires "UPDATE" permissions in order to write to existing DSNSs.

2824128 (1100133)

If a PDS has no members, IEBCOPY now reports that no members were found and does not change
the COND CODE. Previously the COND CODE was set to 4.

2810006 (1098237)
Square brackets are now supported in MFUSERCAT_NODE.

2514366 (1105505)

The incorrect character encoding was used when a PL/I program allocated a dataset using SVC99.
When using multiple catalogs, entries from the last catalog were not always found or displayed when
performing a listing.

Any JESDS OUTPUT statements are now passed to the printer exit if the JCL job log, JESYSMSG, is
printed.

Resolved Issues
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The Job Detail and Catalog Entry pages now support the Shift JIS character encoding. The information
about the character encoding of the Operating System is retrieved from the region and if it is Shift JIS
these pages will now correctly display it.

2853227 (1103407)
The Management Class (MGMTCLAS) is now displayed on the Catalog Entry page.

2581463 (1085180)

To prevent interference with MFFTP execution when running under VSE, edit the VSE configuration file
USE-SYSIN section for MFFTP and assign the permenant instream DD name to SYSIPT (IPTSYS).

2864865 (1105434)
Jobname information is no longer carried forward from one VSE job to the successive jobs.

2864594 (1105072)
A problem processing PAUSE statements in DOS/VSE has been corrected.

2862396 (1104715)
A problem with SETPARM incorrectly assigning a symbolic parameter value has been fixed.

2858580 (1104411)

A SYSIPT read error that occurred when no input data was included in JCL has been changed to return
an EOF instead as is done on the mainframe.

2858377 (1104199)
DLBL allocations before PAUSE statements are no longer lost.

2856861 (1104732)

The maximum number of characters in comments in VSE PAUSE statements has been increased from
44 to 71.

2856412 (1103937)
MFFTP now handles both SYSIPT(VSE) and INPUT(JES2) DD statements for FTP commands.

2855714 (1104139)

Mainframe Access

Back to the list
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Output from the MFDAS GETENQI command now contains line feeds.
2860316 (1104413)

When MFA dependent ASIDs terminated, the message IEF352I was issued "ADDRESS SPACE
UNAVAILABLE". This could lead to the system running out of ASIDs. This has now been fixed.

2856313 (1103876)
Web sites that validate the APPL when passwords are verified no longer reject logons from MFA.

2850696 (1103118)

Mainframe Access now successfully imports and exports binary files that have LRECLs greater than 80
bytes.

2846536 (1102617)

The directory listing for Panvalet libraries now contains the member status flags.

2850501 (1103099)

It is now possible to export files greater than 2 GB in length from a MFA client to a mainframe.

2860982 (1105964)
Unloaded IMS databases larger than 64Kb were corrupted when imported.

2856795 (1104303)



Mainframe Batch Scheduler Integration
Back to the list

* The MFBSI Control-M AutoEdit emulation is now ignoring the IF/ELSE statements block when the
condition is false.

2863481 (1104860)

« The default delays used by MFBSIJCL to check for a job state in Enterprise Server are as follows - two
seconds before each check for "Job Started" and ten seconds before each check for "Job Concluded". It
is now possible to configure these delays in the MFBSI configuration file, mfbsi.cfg, with the following
two new parameters - JOBSTART-LOOKUP-FREQ and JOBEND-LOOKUP-FREQ. Both parameters
accept values between 1 and 60 (in seconds), and AUTO. When AUTO is used, MFBSIJCL uses an
initial frequency of one second for three minutes after which the default values are restored. Using these
parameters will significantly reduce the overhead elapsed time in MFBSIJCL when compared to the
Enterprise Server JCL reported execution time of a job. This has an effect mainly in scenarios when you
have short-running jobs that are frequently executed.

2857416 (1105116)

Micro Focus Directory Server
Back to the list

» Fixed an issue where XA open string which included the
Enterprise Server Administration HTML GUI.

2856722 (1103958)

e If a user attempts to login to the MFDS process using a valid ID but an invalid password the message
"ML3073W Unknown user" is no longer logged in the MFDS journal output.

2842321 (1102116)

character would not display correctly in the

MVS REXX Emulation
Back to the list

» This release provides a technology preview support for the DSNREXX commands for DB2 LUW.
2842140 (1102170)

OpenESQL
Back to the list

e A problem with SQL(SQLCLRTRANS) that caused a COBOL 173 runtime error on stored procedures
that make COBOL calls to other modules has been fixed.

2871330 (1106084)
* A problem using SQL(CHECK) with statements that contain a FOR :hostVariable prefix has been fixed.

2868823 (1105704)

* In managed code only, a problem with the OpenESQL preprocessor sometimes generating incorrect
code after a stored procedure call resulted in some data being returned incorrectly. This has been fixed.
2868405 (1105663)

« Compiler errors sometimes resulted when the SQLCLR wrapper generator generated duplicate
parameter names. This has been fixed by updating the generator to check for the potential of duplicate
names and choose an alternate extension to insure unique names.

2866086 (1105262)

e The OpenESQL Managed Runtime for ADO.NET now allows non-printing characters in PIC X host
variables.

Resolved Issues
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2865166 (1105140)

The OpenESQL pre-compiler incorrectly generated code for programs compiled with
CHARSET(EBCDIC) and SQL(DBMAN=ADO) when SQL statements were greater than 4000
characters.

2864850 (1105064)

Previously, the SPD Generator did not handle correctly some of the parameters which resulted in
generating an incorrect COBOL code.

2864348 (1104993)

The OpenESQL component was updated to resolve an issue executing the HCOSS Assess Application
Migration tool when either no Visual Studio product was installed, or just the Visual Studio Integrated
Shell was installed.

2864021 (1104951)

The SPD generator incorrectly handled quotes around the procedure name, resulting in a compile error
of generated COBOL code. This has been corrected.

2863699 (1104906)

HCOSS was improperly handling UPDATE statements that uses row constructors based on a subquery.
This has been fixed.

2860329 (1104628)
Using SQL(DETECTDATE=SERVER) with queries containing single quote characters sometimes
resulted in an error. This has been fixed.

2857619 (1104103)

The DCLGEN function of OpenESQL Assistant now supports including comments in copybooks for the
Label extended properties on SQL Server columns.

2856215 (1104118)

The SQL(CHECKSP) Compiler directive has been added to list of directives which you can set from the
project's or a file's properties. Also, receiving an error message that the SPD file was not found no
longer causes compiling to hang.

2853668 (1103454)

A problem with the ADO.NET run-time system for OpenESQL not implementing the default threading
behavior for THREAD=SHARE has been fixed, enabling single-user applications, such as Windows
Forms or WPF applications, to use background worker threads provided that the application takes steps
to ensure that only one thread executes embedded SQL statements at a time. When using the
THREAD directive, be aware that ADO does not support THREAD=ISOLATE. For multi-user
applications, we recommend using COBOL run units instead.

2850789 (1103122)

PL/I Support

Back to the list
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A problem when using SUBSTR as an argument to UPPERCASE has been fixed.
2863064 (1104802)

A problem with initialization of structures containing a CHAR(0) member has been fixed.

2868923 (1105719)

A problem with passing an unconnected array reference to an argument with CONNECTED in its
descriptor has been fixed.

2868606 (1105886)

The compiler now diagnoses PICTURE specifications which cause internal compiler implementation
limits to be exceeded.



2868176 (1105602)
A problem with GRAPHIC concatenation causing a SIGSEGV has been fixed.

2867892 (1105565)
? ?roblem with an ENTRY invocation without () has been fixed.

2867705 (1105540)
A problem with a comparison of a BIT(1) to a numeric literal or FIXED BINARY variable has been fixed.

2866657 (1105363)
A possible problem with the scoping of implicit and contextual declarations has been corrected.

2865207 (1105109)

The diagnostic message MFPLI00176S when issued erroneously has been fixed. The text of the
diagnostic has also been corrected and changed to W-level.

2864859 (1105066)

When SQL compilation phase terminates with "Severe errors have been detected during initialization
(FERC=12)", a .list file (or .Ist file on Windows) is now created which contains the Severe diagnostic
messages. Note: The -l option must be supplied to mfplx, or if using an IDE, you must select Generate
listing file (-I) via the PL/I Compile settings.

2863419 (1104854)

A problem with -agginit used in conjunction LIKE erroneously causing Error MFPLIO0126E has been
fixed.

2862202 (1104697)
A problem with CTL structures which contain Fixed Bin(7) arrays causing a compiler Abort MFPLI2000A
with an internal consistency error has been fixed.

2861581 (1104616)
A problem using a function reference in an INIT clause has been fixed.

2860769 (1104496)
A problem diagnosing structures declared with LIKE, and inheriting the CONNECTED (or
NONCONNECTED) attribute, has been fixed.

2860742 (1104489)
A problem with EBCDIC conversion of string literals under the Japanese locale has been corrected.

2859505 (1104311)

A problem with CTL storage and structure expressions has been fixed. This problem caused
unexpected side-effects, for example, structure assignments with BY NAME causing internal compiler
errors.

2859473 (1104309)
A problem causing an error diagnostic to not be shown in the Eclipse IDE has been fixed.

2858299 (1104180)
A DEFINED overlay with bit-strings erroneously diagnosed as invalid has been corrected.

2857736 (1104086)
The compiler now diagnoses PUT DATA without an argument list as unsupported.

2857371 (1104051)
The compiler now does a compile-time check for invalid constant conversions, and provides a Warning
diagnostic to help preempt invalid conversions at run-time.

2854530 (1103602)
A problem assigning unconnected arrays has been fixed.

2850898 (1103139)
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« Bit-field alignment within structures when applying Z/OS mapping rules (-zalign) have been corrected.

2843898 (1102241)

* The Open/PLI compiler now supports STATIC initialization of FILE variables and ENTRY variables.
LABEL variables cannot be initialized at compile-time and an appropriate diagnostic is issued.

2841654 (1102011)
» The compiler now supports initializing static pointer variables to the address of another static variable at
compile time. For example: dcl x fixed bin (31) static; dcl p pointer static initial(addr(x));

2841649 (1101974)

« Previously, if macro code was poorly written and did not contain matching %DO-%END groups, a loop
and/or trap could occur after a message was generated indicating this "Severe" error. The logic in the
macro preprocessor has been modified to issue the message and stop trying to process the macro
code.

2862937 (1104776)

« Previously, if you were using a PL/I macro to generate code that contained exponentiation and in the
generated code the exponentiation symbol ended up on column 71/72, the symbol was split to the next
line. This no longer occurs.

2860875 (1104505)

* Previously, if a macro contained a %DO;-%END; group and -margins 2,72 option was in effect, and the
source contained an asterisk in column 72 immediately followed by the %END; beginning in column 2 of
the following line, then the diagnostic was incorrectly generated. This no longer happens.

2857346 (1104034)

* Previously, if using the macro ANSWER statement within a DO loop, the macro preprocessor would not
emit a complete preprocessed source deck. This no longer happens.
(619151)

» Previously, if reading SYSIN via a PL/I Program compiled with -ebcdic, from a physical dataset in an
enterprise server region running in EBCDIC mode, the input was garbled. This no longer occurs.

2865346 (1105128)

« Previously, if using PUT SKIP(x) where x is greater than 1, on the first line of the first page of a PRINT
CTLASA file, the use of ASA control characters did not mimic the undocumented behavior present in
IBM's PL/I on z/OS. This has now been fixed.

2864096 (1104958)
e Previously, when a CTLASA file was OPEN(ed) and CLOSE(ed) without any data being written, a zero
length file was created. Open PL/I now matches IBM's behavior and emits a single blank page feed line.

2863818 (1104911)

« Previously, if using an EXTFH.CFG where the [XFH-DEFAULT] contained INSERTNULL=OFF, the
compiler would trap when compiling larger complex programs while attempting to read back in a
temporary file created during the parsing phase. This no longer occurs.

2863220 (1105599)
e The PL/I compiler and run time have been enhanced to support the SAMEKEY/() built-in function.

2860459 (1104456)

« Previously, if an ERROR condition was triggered in a PL/I CICS user program and the user program did
not contain its own ON ERROR unit, the PL/I RTS error messages were not driven to the CPLI
temporary data queue. This has now been fixed.

2851930 (1103255)
« A problem printing bit fields within structures has been corrected.

« Previously, the EXEC preprocessor was unable to handle a hex literal constant that exceeded 255 bytes
in length. This has now been fixed.
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2861454 (1104591)

Run-Time System

Back to the list

A statement "MOVE <justified-alphanumeric-item> TO <numeric-item>" no longer produces a
COBRT200 error.

2869985 (1105986)

If the Audit Manager was under heavy load by many client processes and was then re-cycled, it was
possible that the client processes would not send the correct details when attaching to the new Audit
Manager process, which would cause Audit Manager to crash. This is now fixed.

2863509 (1104863)

Pasting of DBCS characters that have a 2nd byte of X"EQ" is now working correctly.

2861398 (1104580)

A dynamically bound application DLL that uses Object COBOL no longer hangs intermittently when
loaded concurrently in multiple threads.

2858271 (1104328)

An additional sub-function has been added to the CBL_GET_PROGRAM _INFO library routine. The
sub-function, number 10, returns a program's full path, or name only, depending on flag settings.
(618769)

Detaching from animation that was started using the debug_on_error tunable could cause animation to
re-start again for the initial error - this has now been resolved.

In managed COBOL code, setting an environment variable to spaces or low-values now unsets that
environment variable.

2864896 (1105147)

You now receive a correct error message when the CBL_CHECK_FILE_EXIST library call is used with
DD_ environment variable expansion on a directory that already exists.

2864515 (1105023)

In the .NET COBOL Run-Time system, default NLS messages are now returned for locales that do not
have the messages defined.

2863236 (1104831)

SQL: Cobsql
Back to the list

A problem with processing an SQL statement when it was on the same line as a COBOL condition
resulted in a CSQL-F-026 error. This has been fixed.

2864989 (1105085)
A problem with COBSQL incorrectly handling EXEC SQL INCLUDE statements has been fixed.

2821960 (1099586)

A problem with COBSQL not recognizing or properly processing a section that comes directly after
comment lines and returning an error has been fixed.

2818934 (1099169)

A problem with COBSQL not properly invoking cobpre64 when COBSQLTYPE is set to SYBASE has
been fixed.

2794407 (1096173)

Resolved Issues
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SQL: DB2 ECM
Back to the list

A problem with the HCO import tool incorrectly handling packed decimals greater than 18 digits has
been fixed.It has been updated to now handle packed decimals up to 26 digits.

2866180 (1105278)

The DB2 pre-compiler sometimes incorrectly restored the RETURN-CODE after a SQL statement was
executed.

2857403 (1104045)

SQL: HCO for SQL Server
Back to the list

An HCOSS problem with statements of the form 'SELECT ... FROM ( (SELECT ...) ...), that is, a table
reference using a nested query that is itself in parentheses, has been fixed with the new STRICTPARSE
SQL compiler directive option. Use STRICTPARSE with DIALECT=MAINFRAME to enhance
diagnostics for DB2 statements that HCOSS does not recognize.

2868603 (1105683)

An issue with HOCSS handling comparison operators that include angle bracket characters has been
fixed.

2867541 (1105520)

An issue that occurred when HCOSS was processing an IN expression using a row constructor in a
nested subquery has been fixed.

2867264 (1105519)

A few issues with the HCOSS emulation of DB2's CHAR scalar function in the formatting date and time
values as character strings have been resolved.

2861301 (1104596)

A problem with SQL(CHECK) for DBMAN=ODBC with queries where the reserved word INNER
immediately follows a host variable has been fixed.

2855930 (1103815)

A problem qualifying sequence names when using SQL(DIALECT=MAINFRAME) and
SQL(QUALIFIER) has been fixed to qualify sequence names in the same manner as as table names
are qualified.

2854747 (1103654)

The Generate SPD File tool generated incorrect code if the name of a called routine was enclosed in
single quotes; this resulted in COBRT173 error when the code was executed.

2853692 (1103481)
The HCOSS Transfer Data tool has been updated to support SQL Server 2016.

A problem with HCOSS incorrectly handling DROP statements when SQL(QUALIFIER) is used has
been fixed.

SQL: OpenESQL
Back to the list

Resolved Issues

The INSENSITIVE option is no longer available for the STATICREADONLY directive.

2871907 (1106251)

A problem with error message handling in the ODBC run time for SAVEPOINT statements has been
fixed.

2870141 (1105889)



A problem with HCOSS incorrectly renaming parenthesized expressions in select lists has been fixed.

2869320 (1105787)
SQL(SPTHROWEXCPETION) now throws an exception only for errors that result when SQL Server
terminates the current transaction.

2868965 (1105736)
SQL(DETECTDATE) would sometimes incorrectly match dates and times in European and USA
formats.

2868282 (1105622)
A problem with the OpenESQL preprocessor failing to properly check the length of an SQL statement
properly, resulting in a 153 RTS error, has been fixed.

2867772 (1105549)
A problem with OpenESQL SQL Entry and Exit not showing in trace output has been fixed. The trace
output is now sent to Auxiliary trace during CICS transaction execution.

2867423 (1105490)
A problem running SQL CLR stored procedures on heavily loaded servers has been fixed.

2865750 (1105229)
A problem with OpenESQL allocating duplicate server cursor names for positioned updates in stored
procedures has been fixed.

2865750 (1105230)
A problem with the OpenESQL Assistant generating copybooks with TINYINT columns as PIC S9(2)
COMP-5 rather than PIC S9(4) COMP-5 has been fixed.

2865378 (1105139)
HCOSS now correctly handles hexadecimal constant strings.

2865026 (1105146)

A problem with the OpenESQL preprocessor when compiling with the CHARSET(EBCDIC) directive
sometimes generating COBCH0002/COBCHO0302 compilation errors for programs that used arrays as
host variables in SQL statements has been fixed.

2864585 (1105039)
OpenESQL now supports DESCRIBE CURSOR statements.

2863839 (1104939)
A problem with HCOSS handling the SUBSTRING function when only three parameters are supplied
has been fixed.

2862754 (1105122)
HCOSS now correctly handles the DB2 TRUNCATE scalar function when the function is called with only
one parameter.

2862064 (1104674)
HCOSS could sometimes report a SQL(CHECK) error as a warning instead of an error.

2861897 (1104668)
The ODBC pre-compiler now swaps array variables using DO UNTIL loops similarly to how it does this
for COBOL. This considerably reduces the number of statements generated for array variables.

2861580 (1104613)
HCOSS now correctly sets SQLCODE = 100 for a rowset fetch that retrieves fewer rows than the host
array size.

2861570 (1104629)
HCOSS now handles correctly FETCH FIRST and ORDER BY clauses in queries that use set
operators.

2861567 (1104751)
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* A problem with OpenESQL incorrectly handling DB CAST expressions that use FOR BIT DATA has
been fixed.

2861516 (1104689)
« HCOSS no longer trims trailing spaces automatically from input host variables when
SQL(DIALECT=MAINFRAME) is set.

2859565 (1104692)
« Previously, you could incorrectly receive truncation warnings for output parameters of Oracle stored
procedure calls that are character fields narrower than 19 characters.

2859200 (1104598)

e Using MySQL ODBC 5.6 or later with OpenESQL in VC/ED 2.3 or later caused an RTS 114 error. This
has been fixed.

2858980 (1105338)
« Problems with the OpenESQL Assistant that caused the "no columns in table" error have been fixed.

2856643 (1103936)
« A problem with applications compiled with the SQL(INIT=PROT) directive caused Enterprise
Server .NET jobs to hang. This has been fixed.

2856198 (1104002)
* HCOSS now supports DB2 RELEASE SAVEPOINT statements and problems with global temporary
table housekeeping and ROLLBACK TO SAVEPOINT statements have been fixed.

2856008 (1103831)

« The SPTHROWEXCEPTION SQL compiler directive option has been added to improve diagnostics
returned to calling applications from COBOL SQL CLR stored procedures in the case of an implicit SQL
Server rollback on a transaction.

2854780 (1103670)
* A problem with OpenESQL not allowing 'NO' to be used as an SQL identifier has been fixed.

2854592 (1103598)

e A problem with the JDBC runtime incorrectly setting SQLCODE on repeat execution of EXECUTE
IMMEDIATE statements has been fixed.

2854393 (1103713)

e A problem processing the EXEC ADO DATATABLE <name> BIND statement resulted in a COBES0100
error. This has been fixed.

2854004 (1103529)
« Some problems with DB2-style result sets where allocated cursors are reused without being closed and
where cursors must remain open across multiple calls to the same stored procedure have been fixed.

2853859 (1103520)

« EXCEL table names enclosed in single quotes were incorrectly handled by the DCLGEN function of the
OpenESQL Assistant, resulting in an unhandled exception. This has been fixed.
2853832 (1103555)

e The COBOL Run-Time system now successfully loads the ODBCRW®64.DLL file when a native COBOL
application is being called from a C# application.
2853578 (1104167)

e The OpenESQL directives SQLCLRTRANS and SPDISPLAY now work correctly for Enterprise
Server.NET batch jobs.
2853439 (1103430)

e An HCOSS problem transforming SQL statements that contain both XML and CONCAT operators has
been fixed.

2853412 (1103426)
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The OpenESQL ODBC runtime has been updated to ensure that connections are closed after a
DISCONNECT.

2853341 (1103461)

HCOSS now correctly handles WITH DEFAULT clauses in table definitions that do not specify a default
value.

2852996 (1103431)

HCOSS now supports DB2 DECLARE GLOBAL TEMPORARY TABLE statements that use AS <query>
and LIKE <tableName>.

2850369 (1103793)

The SQL(PROCOB) directive option for the OpenESQL preprocessor now supports Pro*COBOL's
syntax for calling database functions when SQL(DBMAN=ADO) is also set. In addition, a problem that
prevented DML from being executed in user-defined functions has been fixed.

2849318 (1102957)

The SQL(PROCOB) directive option for the OpenESQL preprocessor has been updated to process
Oracle grouped host array syntax.

2849301 (1102956)

To fix a problem with the DETECTDATE directive not allowing runtime control of datetime data
formatting, the OpenESQL SET <hostvariable> and SET OPTION statements have been enhanced to
allow datetime data formatting behavior equivalent to the OpenESQL DATE, TIME, DATEDELIM,
TIMEDELIM, TSTAMPSEP, and DETECTDATE directives.

A problem with positioned update when using the latest release of the PostgreSQL ADO.NET provider
has been fixed.

The namespace used by the JDBC runtime for OpenESQL has changed from
MicroFocus.COBOL.SqlJVM to com.microfocus.openesql.

The 32-bit Windows DLL names used in OpenESQL JES program-alias mapping have been changed
as follows: SQLTP232 to SQLTP2 SQLUTB32 to SQLUTB.

Using the CHARSET(EBCDIC) directive with OpenESQL sometimes caused the preprocessor to
generate incorrect code for converting SQLCA fields, resulting in CONNECT failures. This has been
fixed.

The SET host-variable embedded SQL statement has been added to OpenESQL to enable you to
guery the current connection name and database type.

Cursor prefetch behavior in OpenESQL has been made more consistent with updates to the
PF_RO_CURSOR and PF_UPD_CURSOR primitive compiler directive options for BEHAVIOR, and the
MARS compiler directive option. See your product documentation for complete details.

SQL Option for DB2
Back to the list

The SQLN value in SQLDA is no longer modified when a FETCH is performed using invalid SQLVAR
SQLDATA pointers.

2854157 (1103541)

A Run-Time System error "-84 UNACCEPTABLE SQL statement" could occur when there was a
VARCHAR host variable definition with an extra 49 level FILLER statement.

2867096 (1105432)

Maodified the XDB precompiler to no longer generate COBSQ0413S errors if the program is compiled
with directive XDB(BEHAVIOR=STACKED).

2855151 (1103687)
The XDBSetup utility supports creating a user XDB.INI in the user's local application space.
2839228 (1101904)
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An issue with scalar functions invoking aggregate functions invoking more scalar functions with
embedded host variables has been fixed.

2869971 (1105862)

A problem that resulted in XDB Server providing incorrect SORT results when using ROWSET
POSITIONING has been fixed.

2867209 (1105454)
Implicit casting is now carried out for SUBSTR() arguments in the V10 XDB engine.

2865204 (1105108)

A problem with uninitialized query common space generating an illegal decimal data error has been
resolved.

2860427 (1104449)

XDB Server has been updated to correctly return results from XDB SQL when certain statement
combinations are executed.

2856158 (1103932)

Some SQL queries that return data on the mainframe did not return data in XDB. These queries now
return data in XDB as well.

2853378 (1103442)

The XDB SQL optimizer has been updated to use a new compound index routine. This corrects a
problem that caused a thread access violation when processing a very large join restriction queue that
had overflowed to disk.

2853078 (1103385)

A problem with the XDB server corrupting a row after executing a program that uses a FOR UPDATE
cursor has been fixed.

2850725 (1103117)

Multiple issues that occurred when the reserved word SELECT was used as an identifier have been
resolved.

2849898 (1103024)

A problem causing the SQL result to be inconsistent when using the SELECT... IN clause has been
fixed.

2849892 (1103103)

A problem when creating a unique index, that resulted in an "x020: Syntax error. Last symbol read was
'INCLUDE™ error message, has been fixed.

2847745 (1102766)

SQL Option now supports PARTITION BY SIZE syntax for DB2 version 9.

2845161 (1102494)

XDB no longer throws an X405 error message when it encounters a NOT operator that is part of a
compound predicate.

2640689 (1088784)

XML Syntax Support

Back to the list

Resolved Issues

In some scenarios, XMLPARSE returned an RTS 114 error while parsing certain XML documents.

2851143 (1103185)
When reading an empty XML document, the returned file status is now -7.

2851074 (1103216)



Other Issues Resolved In This Release

The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

2865238 (1105114)
2871930 (1106185)
2866567 (1105346)
2865516 (1105153)
2865065 (1105097)
2857117 (1104003)
2872217 (1106234)
2864576 (1105124)
2855891 (1103807)
2864100 (1104959)
2867120 (1105479)
2865687 (1105211)
2864343 (1105019)
2858008 (1104163)
2858007 (1104161)
2835721 (1101500)
2835605 (1101499)
2858091 (1104136)
2865419 (1105238)
2864875 (1105074)
2861263 (1104753)
2859986 (1104407)
2855942 (1103906)
2679133 (1093595)
2852255 (1104353)
2856233 (1103855)
2867934 (1105578)
2867215 (1105455)
2866174 (1105419)
2858808 (1104227)
2855088 (1103672)
2853477 (1103462)
2852874 (1103543)
2839669 (1101704)
2836259 (1101305)
2808029 (1098883)
2790796 (1095836)
2854829 (1103653)
2854739 (1103627)
2866458 (1105348)
2865807 (1105205)
2864327 (1104989)
2862599 (1104785)
2848016 (1102774)
2843761 (1102734)
2841092 (1101887)

2865193 (1105135)
2864092 (1106070)
2859740 (1104343)
2859539 (1104350)
2856245 (1103972)
2855704 (1104105)
2855440 (1103871)
2853585 (1103448)
2852872 (1103696)
2852872 (1103930)
2852872 (1103931)
2851306 (1103352)
2840161 (1101839)
2799183 (1096680)
2863024 (1104786)
2853074 (1103489)
2848947 (1103100)
2816310 (1104173)
2859923 (1104371)
2650949 (1090062)
2854470 (1103640)
2857870 (1104107)
2809343 (1099937)
2858035 (1104156)
2856499 (1104222)
2857318 (1104188)
2858539 (1104204)
2856795 (1103963)
2840704 (1103249)
2863482 (1104862)
2861561 (1104610)
2860719 (1104512)
2858941 (1104253)
2858723 (1104229)
2856941 (1103977)
2856206 (1103880)
2861649 (1104679)
2853710 (1103578)
2867842 (1105600)
2865028 (1105119)
2860212 (1104480)
2854400 (1103587)
2852486 (1103340)
2842820 (1103533)
2855179 (1103705)
2855179 (1103707)

2819868 (1099861)
2865350 (1105129)
2864599 (1105025)
2853376 (1103486)
2855231 (1103701)
2870740 (1106000)
2858161 (1104152)
2864758 (1105772)
2856295 (1103875)
2839181 (1101830)
2864619 (1105054)
2861296 (1104593)
2860006 (1104387)
2854108 (1104290)
2848917 (1103264)
2838891 (1101791)
2648290 (1089566)
2864197 (1105004)
2852655 (1103333)
2869703 (1105832)
2869126 (1105760)
2852996 (1103913)
2859001 (1104312)
2869594 (1105948)
2867462 (1105499)
2866779 (1105567)
2865650 (1105214)
2865630 (1105243)
2865078 (1105100)
2865051 (1105317)
2865003 (1105132)
2863175 (1104845)
2860863 (1104746)
2860785 (1104563)
2859507 (1104314)
2859155 (1104316)
2859044 (1104282)
2857023 (1104176)
2857021 (1103995)
2856592 (1104053)
2852281 (1103298)
2818259 (1099422)
2865602 (1105177)
2863239 (1105044)
2861423 (1104585)
2858787 (1104233)
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e 2869763 (1105896) e 2851107 (1103173)
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Installation

Before Installing

Downloading the Product

You can download Enterprise Developer from the Product Updates section of the Micro Focus SupportLine
Web site.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

e This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

« The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

f Note:

* You can produce both 32-bit or 64-bit applications with Enterprise Developer installed on a 64-bit
operating system.

» This product can be installed on earlier versions of Windows but it has not been tested on them.

Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

i Note:
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» Besides the software listed below, the setup file also installs the 32-bit Java 8 Update 51.
» This product includes OpenSSL version 1.0.1p.

Visual Studio IDE
This product requires Microsoft's Visual Studio.

You need one of the advanced versions of Visual Studio listed below or the Visual Studio Integrated Shell
(only supported by Enterprise Developer for Visual Studio 2012 or 2013):

Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)

Microsoft's Visual Studio Express Edition is not supported.

If there is no Visual Studio installed on your machine, the setup file for Enterprise Developer for Visual
Studio 2012 or 2013 will install the Visual Studio Integrated Shell. Alternatively, you can download the
Visual Studio Integrated Shell from the Microsoft Download Center and install it before you install
Enterprise Developer. If you choose to install the Shell, ensure you run the installer to complete the
installation - run vsintshel I _enu.exe from the location where you installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or the
Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for more details.
, Important:
» A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Enterprise Developer for Visual Studio 2013.

« Enterprise Developer for Visual Studio 2015 does not support Visual Studio 2015 Shell as the
Shell has a number of restrictions to COBOL development. The Visual Studio 2015 Shell is not
included in the setup for Enterprise Developer for Visual Studio 2015 and before you start the
installation, ensure that there is an advanced edition of Visual Studio 2015 installed on your
machine.

e On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the
Microsoft Download Center.

» Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

» Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.


http://www.microfocus.com/docs/links.asp?nx=ctl1
http://www.microfocus.com/docs/links.asp?nx=ctl1
http://www.microfocus.com/docs/links.asp?vc=RyuJIT_advisory
http://www.microfocus.com/docs/links.asp?vc=RyuJIT_advisory
http://www.microfocus.com/docs/links.asp?vc=RyuJIT_testing
http://www.microfocus.com/docs/links.asp?vc=mskb3088955

» Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

* Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.

e Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

The following software is also required:

« Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

* Microsoft NET Framework 4.5. This is included with Visual Studio 2012.

* Microsoft NET Framework 4.5.1. This is included with Visual Studio 2013.

* Microsoft NET Framework 4.6. This is included with Visual Studio 2015.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing
Enterprise Developer on a machine that has no Visual Studio 2013 installed, the setup file installs Visual
Studio 2013 Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's
Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

Other Requirements

/1, Important: This release requires version 10000.2.990 or later of the Micro Focus License
“*= Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

Product Co-Existence

» Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

« Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation
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Installation Restrictions and Requirements

Before starting the installation you should consider the following:

If, when you install Enterprise Developer for Visual Studio 2012 or 2013, the machine does not have
Microsoft Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by
Enterprise Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number
of .dl1 files, without digital signatures, into the winsxs directory.

If, when you install Enterprise Developer for Visual Studio 2015, the machine does not have Microsoft
Visual C++ 2013 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .d11
files, without digital signatures, into the winsxs directory.

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

On UNIX

Hardware Requirements

The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:



Platform Installer type Setup Disk space Disk space Sentinel RMS
file size required for required for license
(MB) the installation running server

the product (11
(MB)

POWER Micro Focus installer 479 1.91GB 958 36.5

running AlX

HP 1A Micro Focus installer 866 3.46 GB 1.73GB 69

System Z Micro Focus installer 390 1.56 GB 780 36

running Red

Hat Linux

x86-64 Micro Focus installer 431 1.72GB 862 46

running Red

Hat Linux

SPARC Micro Focus installer 492 1.97 GB 984 40

running

Solaris

System Z Micro Focus installer 394 1.58 GB 788 36

running SUSE

SLES

x86-64 Micro Focus installer 437 1.75GB 874 46

running SUSE

SLES

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements for Micro Focus Enterprise Developer Unix

Components

These are the software requirements for Micro Focus Enterprise Developer Unix Components:

* The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems

but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --

version at the command line.
« Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating

Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before

you start the installation.

Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7
glibc-locale-32bit X X
glibc-*.x86_64 X X
glibc-*.i686 X X
libgce-*.x86_64 X X
libgcc-*.i686 X X
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Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

libstdc++-*.x86_64

libstdc++-*.i686 X X
gdb* X X X
elfutils-libelf-** X X X
libelf- X X X
devel-0.137-8.19

*%

libelf1-0.137-8.19* X X X X
*

libelf1-32bit-0.137- X X X X

8.19**

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

** Operating system libraries required for PL/l support on both SUSE and Red Hat.
Visit the Red Hat Web site for more information.

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required for native COBOL and Java
interoperability. The setup file installs Java 8 u51 32-bit. You can download Oracle's Java EE from
Oracle's Web site and install it anywhere on your machine.

y Note:

e On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

e On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.
To execute COBOL JVM code, you need to set the environment as follows:

* You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA HOME=j ava_install _dir

where java_install_dir is the path to the JAVA installation directory such as /Zusr/java/javan. n
* You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_ HOME/bin:$PATH

* You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have icons
true
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Additional Software Requirements for Micro Focus Enterprise
Developer Unix Components

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

UNIX and Linux Installer Issues

License Server
You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:
127.0.0.1 localhost.| ocal domai n localhost

I P machi nel onghost nanme nachi neshort host nane

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation

The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing

f Note:

» This version of the product is a full install.

» See Before Installing first for important information. Also, see Installing as an Upgrade, if you have
an earlier version of Enterprise Developer installed on your machine.

To install this product:

1. Runthe edvs2012_232_exe file (or edvs2013_232.exe, edvs2015_232.exe) and follow the wizard
instructions to install the prerequisite software and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba. The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

f Note:

» When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a known Microsoft issue. To resolve it,
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follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

» If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

» Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

*  We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

» If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Micro Focus Enterprise Developer Unix
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1.

Give execute permissions to the setup file:

chmod +x setup_entdev_2.3 update2 pl atform
Run the installer from the Process User ID login:
-/setup_entdev_2.3 update2 pl atform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into Zopt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

-/setup_entdev_2.3 update2_ pl at f or m -skipsafenet

To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server


http://www.microfocus.com/docs/links.asp?nx=ctl1
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processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks

This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

» Installing as an Upgrade - included in these Release Notes
e Command line installation options - included in these Release Notes

« Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus
Infocenter

« Installing the Mainframe Components - available in the product Help and in the Micro Focus Infocenter
« Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus
Infocenter

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

On Windows

Installing as an Upgrade

Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.

« Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Developer Installation Options

To install Enterprise Developer you run edvs2012_232.exe which contains a number of product .msi
files (Windows Installer packages). When run, edvs2012_ 232 .exe performs some initial system checks
then sequentially installs the .msi files.

Note: The following applies to edvs2013 232 .exe when installing the product for Visual Studio
2013. The following applies to edvs2015 232.exe when installing the product for Visual Studio
2015.

edvs2012_232._exe can take a number of parameters, enabling you to specify a number of different
types of installation:

+ Standard Installation

Format:
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edvs2012 232 .exe
Summary:

Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

* Non-interactive Installation

Format:

edvs2012_232.exe /passive

Summary:

Full installation, but the components are installed non-interactively using default options and
directories.

¢ Silent Installation

Format:

edvs2012_232.exe /q

Summary:

Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

* Modified Silent Installation

Format:

edvs2012 232.exe /q InstallFolder=d:\otherdirectory

Summary:

Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

Format:
edvs2012_232._.exe /q RumbaCheckbox=1

Summary:

Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components

are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2012_232_exe /2.

f Note:

On

Log files that are created during installation are saved in the folder specified by the TEMP

environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp

\log. txt. This creates a log file, named log. txt, in the d:\temp directory.

UNIX

Installing as an Upgrade

This release works concurrently with the previous version of Micro Focus Enterprise Developer Unix

Components, so you do not need to uninstall it. There are two options for installing the latest version in this

case:

* Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/
EnterpriseDeveloper, by default).

This ensures you do not need to change your environment. To move the existing older installation to a

different location:



1. Execute the following command as root:

mv /opt/microfocus/EnterpriseDeveloper /opt/microfocus/
EnterpriseDeveloperver si on

2. Install the latest version as described in the section Installing.
« Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer Unix Components installer with the —installlocation option:

1. Execute the following command:
- /Zlnstall File -installlocation="/opt/microfocus/EnterpriseDeveloper"

y Note: You can use variables or the tilde syntax for the path for —instal 1 location. For
example, the following examples are equivalent:

-installlocation="/home/myid/i nstal | di r "
—-installlocation="~myid/i nstal I di r"
-installlocation="~/instal ldir"

—-installlocation=""$HOME/i nstal | di r "
2. Execute cobsetenv to set the environment and point to the new install location:
. /opt/microfocus/EnterpriseDeveloper/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer Unix Components Installation
Options

Installing into a different location

To install in a different location use the —instal I location=""Location' parameter to specify an
alternative directory location. For example:

./setup_entdev_2.3 update2 pl atform -installlocation="full path of new
| ocati on"

f Note: You can use variables or the tilde syntax for the path for —instal I location. For example,
the following examples are equivalent:
—-installlocation=""/home/myid/i nstal | di r "

-installlocation="~myid/i nstal | dir"
—-installlocation="~/instal l dir"
—-installlocation=""$HOME/i nstal | dir "

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="l ocation'™ ] [ -ESadminID="User ID" ] [ -CASrtDir="l ocation' ], where:

-ESsyslLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog=""/home/esuser/l1ogs". The default location is /var/mfcobol/

logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID=""esadm". The default user ID is the one that runs the installer.
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-CASrtDir  Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir=""/home/esuser/casrt/es". The default location is /var/

mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:
—silent -lacceptEULA

For example, execute:
[as root] setup fil enane —silent -lacceptEULA

After Installing

« See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.

» Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows

Starting the Product
You are now ready to run Enterprise Developer:

* From the Windows taskbar, click Start > All Programs > Micro Focus Enterprise Developer >
Enterprise Developer for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8, Windows 8.1, and Windows Server 2012. You
use the Start screen to invoke programs.

To view the documentation installed with your product:

« Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu click
Help > Set Help Preferences > Launch in Help Browser.

For full details of the Visual Studio Help system, see the locally installed Microsoft Help Viewer Help, which
is available from Help menu in the IDE.

Note: On some Windows versions such as Windows 8 or Windows Server 2012, an issue with
Microsoft Help Viewer and Internet Explorer's security being turned on can cause the Help content to
be displayed as raw HTML code. To resolve the issue, you need to turn off the Internet Explorer
Enhanced Security Configuration (IE ESC) for both administrators and users. Check the Microsoft
Windows help for more information on how to do this.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
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Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e TheMicro Focus Product Nane folder in the Start menu - you can delete it manually.

* Y%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.

* %ProgrambData%\Micro Focus - includes some data files used by the Micro Focus licensing system.

 %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /Zquiet Zuninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

* Micro Focus Server\Performance\Active Servers
* Micro Focus Server\Performance\PerfiniFile

On UNIX

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstal l_EnterpriseDeveloper2.3.sh script in the $COBDIR/bin
directory.

Installation
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Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
i Note:

» If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

» Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

Installing licenses

If you have a license file

n

4.

Start Micro Focus License Administration.
Click the Install tab.
Do one of the following:

« Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

» Drag and drop the license file from Windows Explorer to the License file field.

e Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.

Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1.
2.

o g s w

Start Enterprise Developer.

Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog
box.

Ensure | have a full Enterprise Developer Team Edition license is checked.

Click Browse next to the License file field.

Select the license file (which has an extension of _.mFlic), and then click Open.

Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

Licensing Information
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If you have an authorization code

Authorizing your product when you have an Internet connection

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

w N e

4.

Start Micro Focus License Administration.

Click the Install tab.

Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

L A

© o N>

Start Micro Focus License Administration.

Click Manual Authorization on the Install page.

Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:

« If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

« If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.

Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

Type the Machine ID in the Machine ID field.
Type your email address in the Email Address field.
Click Generate.

Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

10.Click Install Licenses.

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

Licensing Information



Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

« The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

* The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

i Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

e The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

e The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusintl.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

« The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

* Your operating system version number and details of any networking software you are using.

* The amount of memory in your computer.

* The relevant page reference or section in the documentation.

* Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportinfo, to create
either:

« a . logfile that contains the details about your environment, Micro Focus SupportLine products, and
settings.

e a .zip archive that includes the same information as the . log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportinfo.exe is stored in <i nstal | - di r >\bin.
To run MFSupportinfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a . log file or a .zip archive as follows:

a. To create a . log file, click File > Save.

This prompts to save the . log file, MFSupportinfo_Log Machi neNane_YYYY-MM-DD_ HH-MW-
SS. l1og, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportinfo_Log Machi neNane_YYYY-MW-DD HH-MW-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either

the . log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fithess for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.
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